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3.5 Designing and producing a newsletter in Photoshop CS6 

The idea behind this chapter is to show to the learner different 

tools of Photoshop, whilst he/she can create a useful newsletter 

used to keep in contact with partners and the audience of the 

website. 

The idea is to create a newsletter with the help of Photoshop CS6 in whatever 

way we want to, not being limited by the online newsletter editors and 

generators. 

First we need to design the document in Photoshop as an image. After that we 

will slice the image document in different areas, corresponding to HTML elements 

(images, text, links etc.) 

In this chapter, we will start with the steps necessary creating the image that will 

be the base for the newsletter, and in the next one you can learn how to 

transform this image in the right format to be able to send it as a newsletter. 
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3.5.1 Getting the document ready  

Step 1 

Begin by creating a new Photoshop document (File > New…). The majority of 

email newsletters have a defined width of around 620 total pixels.  

 

 

Anything below 620px is ok, so we can make sure the newsletter can be shown on 

any type of device. 

We will use a total width of 680px, so we can ensure the width of the content will 

be 600px. 
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Step 2 

Add some guides to help you fit the 

text in the width of 600px. 

Go to View > New Guide… and set 

some guidelines on the sides as 

well as a guideline in the middle so 

we can easily align things.  

 

 

Step 3 

To keep everything organized (easy to 

navigate and edit) we will use 4 layer 

groups, each for different parts of the 

newsletter: “header”, “message”, “quote”, 

“best”. 

To create groups go to Layer > New > Group  and name them as mentioned 

before. 
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3.5.2 Preparing the background 

Step 1 

The background has to be not too 

fancy or distracting as many email 

users won’t see it on smaller 

screens. The background shouldn’t 

be an image as it will be blocked by 

default on many email clients. 

Change the foreground color to very 

light blue #d2d9d2 and hit 

Alt+Backspace to fill the 

“Background” layer. 

 

 

Step 2 

Set a background in the safe area where all email content will be put(600px). Pick 

the Rectangle Tool (U) and draw a white #FFFFFF rectangle between the first and 

last vertical guidelines that are 600px apart. 
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 3.5.3 Designing the header 

The header of our email is very important and is the crucial point where the email 

recipient will decide if reading further is worth their time. We will simply put a 

company name and a link for people to open the email in a web browser in case it 

doesn’t load properly via the email client. 

Open up the “Header” group and pick the Horizontal Type Tool (T). You may find 

it better to write your company name rather than use a logo because images may 

be disabled when your email is opened so it can ruin the experience because your 

logo won’t be visible. 

 

Step 1 

It is very important to provide a link that people can click or tap on and open the 

email in their browser in case it doesn’t render very well in the email client. Just a 

simple text link will do the job, placed early on so screen-readers encounter it 

straight away. 

 

 

Step 2 

 Grab the Rectangle Tool (U) and draw a 600x300px sized box between the 

first and last guidelines. 

 Now pick the Gradient Tool (G) and choose the default gradient from red to 

green. 
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  Then place the photo of your choice on top of the rectangle 
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 Step 3 

Now set the layer blending mode 

to Overlay. 

 

 

 

 

 

 

 

 

 

 

 

Step 4 

Write your header message. 

When designing email newsletters make sure to keep your message short and 

clear so users get it right away. 
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3.5.4 Designing the message area 

Step 1 

Use TEXT Tool to write your main message. 

It is smart to design your emails in one column and centrally aligned so it can be 

made into responsive layout easily. 
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Step 2 

You have the reader’s attention and now it’s time to put a call to action button so 

your email leads somewhere useful. 

Create a new rectangle of red color and use text tool to write the call to action on 

the rectangle in white 

we need to close the block by separating it with a line; set the foreground color to 

light blue #eeeeee and pick the Line Tool (U) with Weight set to 1px. 
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 3.5.5 Designing the “Best of” area 

Step 1 

One very common feature in email digest 

newsletters is sending out latest articles that 

readers may have missed or would be interested 

in. When designing such a module you need to 

keep in mind that it is going to be a dynamic 

element so you need to set up the scene leaving 

the email creator to replace the information. 

I will list out some articles. I’ll simply use article 

images, titles and descriptions from Erasmus+ projects 

Create a new group called “Article”. Grab the Rectangle Tool (U) and, holding 

down the Shift key, draw a 140x140px sized box. Then pick an article image and 

drag it to your Photoshop window. 

Step 2 

Now we need to enter the article title and short description so the reader can get 

a quick overview before clicking or tapping. 

Use the TEXT tool to write a title and a description with different font sizes. 
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 Duplicate the first article and then modify to have more articles. 

 

 

 

 

 

Step 3 

Finally duplicate the “CTA” group and move these layers into the “Best” group 

and place them below the articles leaving enough space. 



 

14 
 

 

 

 

 

3.5.6 Designing the quote and footer 

Step 1 

Let’s put a final block in our newsletter, an inspiring quote with a secondary call to 

action to tweet it. Best practice is to repeat the main call to action at the very end 

of the newsletter, but we will break this rule here and use an inspiring quote to 

energize the reader. 

Then add a Facebook button, by downloading an icon and add it creating a new 

layer. 
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Step 2 

Insert footer and unsubscribe option using TEXT tool. Reuse the “Open in 

browser” link from the very top, duplicate it and place it below the content 

background. 

 

 

Step 3 

In the url of your text add 

mailto:name@domain.com?Subject=Unsubscribe%20Me 
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3.6 Create and send an HTML email template (newsletter) with Photoshop CS6 

This chapter focuses on showing how you can start from a normal image in .jpeg 

format and create an HTML email format (a newsletter) with the help of 

Photoshop CS6. 

After this is done, we will see how to use the document on the WWW by using a 

global URL. Finally, the user can see how is possible to send the HTML email 

template (the newsletter) via Outlook and Gmail. 

.jpeg format is used for images across the Internet because of the low space in 

memory the files in this format use. This format is used because the images take 

less space, although they loose quality, when they are converted from a loose less 

format to .jpeg.  
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HTML is a mark-up language used to create and describe web pages. Your 

Internet browser reads the .html source code of the page you are navigating on 

and exhibits the content in the way showed by the code. 

 

3.6.1 Transform the .jpeg format file into .html format file 

Step 1 

You have an image that will serve as the newsletter ( created in the previous 

chapter). Open it in Photoshop. 

 

Step 2 

You have to create areas that are going to separate HTML elements, using the 

Slice tool. 

Practically, you have to organize (split) your email layout in multiple zones (slices).  

Here are a few tips to create the best email slices 

 whenever possible, try to align your slices horizontally, like creating a table 

where all cells align to horizontal lines; 
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 each slice should contain one clear element (image or text). Your logo 

should form a single slice, your email title text should form another single 

slice, etc; 

 avoid leaving image areas that are not part of any slice, even if they are 

blank (white) spaces. Make separate slices for them, too; 

 try to split the email image into areas that hold single, solid colors. For 

example, if you have a grey area and a yellow area, make a slice for the grey 

area and another slice for the yellow area. This way you can later apply HTML 

background colors to these slices, instead of nesting colored images of those 

areas. 

 

 

You need to specify the type of each slice: image slice or text slice (“no image” 

slice). Image slices are those areas that need to be preserved as images (like your 

logo or product box), while “no image” slices are those email areas that are going 

to hold various email texts. 

In order to specify the slice type, right click over the selected slice and choose Edit 

Slice Options. Don’t create image slices for those areas that only contain a 
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single, solid color. Instead, create a “no image” slice (with no text on it) and 

assign the desired color as the slice background color. 

 

Step 3 

We will slice each section corresponding to the content. 

In the following example : IMG + Hyperlink 

 

 

In the following example, the area is constituted by blue background without text 

so we will specify accordingly. 
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In the next example the selected area has only white background. We need to 

specify the type of each section, including each section of white background. 
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The final image that was sliced in different sections should look like this: 
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Step 4 

Go to File -> Save for Web.. 

  

Step 5 

Press Save… 
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Step 6 

In Settings press Other… 

 

Step 7 

Choose Slices 
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Step 8 

Put in the following Settings then press OK 
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Step 9 

Press Save and behold your masterpiece 

 

 

 

 

 

 

 

 

 

3.6.2 Use the file everywhere on the Web 

Notice that in your save folder two new 

things appeared: 

 1 .html file containing your 

newsletter 

 1 folder containing the images of 

your newsletter 

For being able to use the images anywhere they need to be uploaded to your 

server. 
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After we uploaded the files on the server of the website, we need to update the 

URL of our images in the .html file Christmas_email. 

It will be changed from “images/”, that was the folder where I saved the 

newsletter, to the new Global URL, meaning the place on our server where I put 

the photos http://www.mobilityfriends.org/newsletter 

To change the folder, we open the .html document with a code editor (Notepad 

or I am using Notepad++) 

Hit Ctrl+F -> Replace then we replace “images/” with 

“http://www.mobilityfriends.org/newsletter/ “ and hit Replace All 

http://www.mobilityfriends.org/newsletter
http://www.mobilityfriends.org/newsletter/
http://www.mobilityfriends.org/newsletter/
http://www.mobilityfriends.org/newsletter/
http://www.mobilityfriends.org/newsletter/
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Now your template can be used anywhere on the internet because when you will 

access your newsletter, the photos contained in it will be downloaded from your 

domain. ( for example: www.yourwebsite.com) 

  

3.6.3 Sending the HTML email template (newsletter) 

Once you have your .html newsletter you have to send it to your contacts. To do 

that, you have more options, but I will concentrate on two common ones: 

 Sending through Outlook 

 Sending via Gmail  

 

 

 

 



 

28 
 

3.6.3.1 Sending through Outlook 

Once you have the .html file for your newsletter you can upload to your Outlook 

as follows: 

 Copy & paste the .html file to the %appdata%\microsoft\stationery 

folder. This is where Outlook saves Email Templates 

 

 

 if you want to set this template as your default Outlook email theme, go 

to your Outlook Options menu -> Mail -> look for the “Stationery and 

Fonts” button: click on it, then select the template that you saved above 

and click OK to set it as the default email theme. 

 

 

 you can now create a new Outlook email and you will see that Outlook 

will automatically apply your Outlook email template for all emails you 

are composing.  
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3.6.3.2 Sending using Gmail 

To send using Gmail we need to Open and write a new Email in Gmail using 

Chrome browser. 

We write some random words, select, Right click and hit Inspect. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the source code of the page, we will identify our random text “blabla”, we will 

select it and hit Right click and Select “Edit as HTML: 
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We will open our .html newsletter with a code editor (Notepad++). 

We will select everything that is contained between the <body> tags and we 

copy it using Ctrl+C. 

 

We go back to Chrome and paste the contents of the .html newsletter instead of 

the random text “blabla”. 
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Behold your creation and send it to everyone. 
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3.7 Designing and sending email newsletters using MailChimp 

3.7.1 What is MailChimp? 

 MailChimp is an email marketing service and the trading 

name of its operator, an American company, founded in 

2001. By June 2014, it was sending over 10 billion emails 

per month on behalf of its users. 

 MailChimp provides marketing automation for e-commerce businesses. Send 

beautiful emails, connect your e-commerce store, advertise, and build your 

brand. 

 It allows newsletter designing, editing and campaign monitoring and marketing 

 

First page of the website  
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3.7.2. Creating a newsletter 

Step 1  

Create a new account on http://www.mailchimp.com 

 

 

Step 2 

Create your audience ( email list). 

 

Give your list a name and complete the other settings. 

http://www.mailchimp.com/
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Manage your contacts, either by importing subscribers or by creating a signup 

form, for people to complete.

 

For importing subscribers you have more choices to choose from, depending in 

which you have your email database. 
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The way to create a signup form is showed in the following images. Observe that 

here you also have 3 options to choose from: 

 General forms 

 Embedded forms 

 Subscriber pop-up 

Each of this ways is useful for you for different types of audiences. 

 

 

For example, to create an embedded form (html code), you just have to choose 

the “Embedded forms” option and to copy + paste the generated source code 

into the webpage that you want to contain the subscriber form. You can choose 

multiple options, depending how you want your form to be. 
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Step 3 

Create your campaign! 

 

The website offers you guidance for you to choose the appropriate tool needed. 
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We are interested in creating a newsletter, so we will choose the “Create an 

Email” button. 
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Then we will fill in our Campaign Information. For the purpose of this course, we 

choose the subject of the newsletter to be a Christmas card, made for our 

partners, to wish them happy holidays. 
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Select which template you think is suitable . 

 

After this, you have arrived to the editor of the newsletter. Here you can choose 

to add text or images, and fill every section. 
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Add subscribers to newsletter. 

 

 

Save your template for further usage. 
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Fill the list with the emails you want to send the newsletter to. 

 

Select your favourite template (in this case, our Christmas newsletter). 
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Before sending, make sure everything is set right. 

 

Send your newsletter. 
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After sending your newsletter you have 2 more options: to track performance in 

Reports or to track your performance in the Mobile App. 

 

 

In Reports you can check out all the statistical data about your newsletter 

campaign. 

 

MailChimp also offers you the HTML source code of the newsletter, in case you 

want to add to your domain, or to other webpages. 
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3.8 Top 10 mobile applications for Non-Governmental Organisations 

This chapter is dedicated to mobile applications that we can use in the workplace 

to make our life easier when it comes to administrate our tasks and deadlines, or 

that create opportunities for dissemination or finding new projects, working as 

marketing tools. 

What is very important when you talk about working in the environment of a 

Non-Governmental Organisation is that is a specific environment, usually with 

people from different countries, that speak different languages, and understand 

team work in a different way. That is why is very important to have tools, 

systems, that synchronise us when working together. 

In this chapter we will analyse 10 applications related to different aspects of 

working in an NGO. 

For the area of Communication and Organization we will talk about the following 

apps: Outlook, WhatsApp, Google Calendar, Slack. 

Asana, Google Drive and Podio can be helpful when it comes to Project 

Management, Marketing and Team Management. 

Finally, for image an video editing, we choose Snapseed, Adobe Premier Clip and 

Office Lens. 

 

3.8.1 Outlook 

A few things that you can do with Outlook:  

 Emails, calendar and meetings, shared documents and 

contacts, all in one place. 

 Keep your email box accessible on the go – read, write 

and reply to your emails 

 Consult your  calendar and create meetings and 

events. 

 Documents shared by email easily available. 
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 Quickly access your contacts – for those times an email is just not quick 

enough. 

 

3.8.2 Whatsapp 

Why use Whatsapp?  

 Alternative to SMS 

 Send written and voice messages, photos and videos 

– capture and share any moment of your day instantly 

 Create groups up to 256 people big 

 Share documents easily 

 Automatically imports your contacts 

 

3.8.3 Google Calendar 

Google Calendar has 3 important tools:  

 Reminder creation 

o time and date 

o associated with phone contact, email, etc 

 Event creation 

o Location, time, periodicity, people, 

attachments from drive and notes. 

o E-mail invitation w/ notes, location and etc 

o Notification of acceptance 

 Goals 

o Themes: build a skill, exercise, family time 

o How long, how many sessions, etc 

o It finds time for you 
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3.8.4 Slack 

Slack provides:  

 All-in-one (integration with dozens of Apps for 

multiple purposes) 

 Chat for team members (group and direct) 

 Easy use of integrated apps 

 Direct connection to Google Drive 

 

 

 

3.8.5 Asana 

With Asana you can:  

 Create account or sign in with Google account 

 Create tasks to plan your day and prioritize them as 

you like 

 Individual tasks vs. Team Projects 

 Team Projects: 

o Group Conversations 

o Assign people to tasks 

o Check on task progress 

o Add files from computer, dropbox or google drive 

 Post updates to a Slack channel when there are changes in your Asana 

workspace 
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3.8.6 Google Drive 

Google Drive provides:  

 Documents storage (excel, docs, forms, pptx) 

 Simultaneous Editing of documents 

 Comments on documents notified by e-mail 

 Shareable documents through automatic e-mails 

with description 

 It allows a structured organisation 

 

 

 

3.8.7 Podio 

What you can do with Podio:  

 Create workspaces, teams, assignments, projects 

and events 

 Assign people to projects and tasks, set deadlines 

and attach files to tasks 

 Personalize it! 

 Work with google sheets, google drive, one drive, 

dropbox, evernote, campaign monitor, google 

calendar and many more 

 Install extensions 
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3.8.8 Snapseed 

Snapseed offers you:  

 Quick and powerful photo edit on the go. 

 Crop, adjust settings, add text and effects. 

 Easy and intuitive interface. 

 Grand variety of amazing filters – make your 

images look a million bucks. 

 Face detection  for enhancement – to take your 

selfie game to the next level! 

 

 

 

3.8.9 Adobe Premier Clip 

With Adobe Premier Clip you can:  

 Import your files from several sources – your device 

or camera, Dropbox, Google Photos, Google Drive, 

Lightroom or Creative Cloud.  

 You can create your videos with the help of the 

automatic edit or  or do it by yourself in the freeform 

option. 

 Trim, reorganize, add effects , a soundtrack and 

watermark – all within the reach of your thumb 

 Quickly save and share you projects 
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3.8.10 Office Lens 

Things you can use Office Lens for: 

 Pocket scanner – you can shot from any angle 

 You can save your scan in several platforms - 

OneNote, OneDrive, Word, PowerPoint, PDF and 

your Gallery. 

 Edit the image cut – in case  the app need a little help 

 Choose the type document being scanned for better 

results – Document, Whiteboard, Photo or Business 

card 

 

 


